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Partl

QUESTION: 1

Which of the following contextual tabs consists of controls to select the initial layout of a form and the default positions of controls on the
form?

@ A: Arrange
@ B: Format
@ (: Page Setup

@ D: Design

Explanation: Answer aption A is correct,

The Arrange contextual tab is highly context sensitive. It consists of controls to select the initial layout of a form and the default positions

of controls on the form.

Home | Create | External Data Database Tools l Design Arrange Format | (A1 0

@ e B tnsert Below [ Select Layout =] =
’*l HE misert Lert [ select Column
Gridlines Tnsert Merge  Mowe  Position  Sizing &
E Ahoye il Insert Right B Select Raw £ Split= > = Crdering =
Table | Fows & Columns | | | | |

Answer option Disincorrect. The Design contextual tab is used to add new elements, change the header/footer, and apply themes to the

form.
Answer option B is incorrect. The Arrange tab has various layout options.

Answer option Cisincorrect. This contextual tab is not available on the form.

QUESTION: 2

Where can a user add any Access command as & button in Microsoft Access 20107

© A: Macro
¥ B: Navigation Pane
@ C: Quick Access Toalbar

D Index

Explanation: Answer option C is correct.

The Quick Access Toolbar in M5 Access 2010 is a customizable toolbar which is displayed in the title bar of the Database window. It has a set
of commands or functions (save, undo/redo, and print) that are independent of the tab on the ribbon currently displayed in MS Access. The
Quick Access Toalbar can be moved from one of the two possible locations. A user can add any Access command as a button to the Quick

Access Toolbar.

Answer option B is incorrect. The Navigation Pane provides an interface for all database objects, such as tables, queries, forms, reports,

macros, and modules. Itis located along the left side of the Access screen. In the Navigation Pane, all items are organized into groups. Itis
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also used to show or hide the database objects.

Answer option A is incorrect. In Microsoft Office Access 2010, a macro is a database object that defines the actions that are required for
Access to perform as a result of a defined event. Itis also used to open and execute queries, open tables, and print or view reports. A user
can add simple conditions in macros to specify when actions are performed or skipped.

Answer option D is incorrect. In Microsoft Office Access 2010, an index is alist of field values induded in a table. It helps Accessin finding

and sorting records quickly. An index stores the record's location based on the columns that are part of the index. The indexed fields have
unique values which make it more efficient and faster for Access to read and find a specific field value.

QUESTION: 3

Which of the following are the ways to create a join between two tables in Microsoft Access 20107

Each correct answer represents a complete solution. Choose all that apply.

¥ A: Select two tables for the query that have a field in common.
[N B: Create relationships between the tables while designing the database.
7 C: Use the Object Dependencies pane available on the Relationships group.

I D: Modify the default join behavior.

Explanation: Answer options B, D, and A are correct,

Following are the three ways to create a join between two tables in Microsoft Access 2010:

1. Create relationships between the tables while designing the database.
2. Select two tables for the query that have a field in commaon. This field has the same name and data in both tables.
3. Modify the default join behavior.

Answer option Cisincorrect. The Object Dependencies pane is available on the Relationships group in the Database Tools tab. It
demanstrates the interactions or dependencies of all database objects. It helps in preventing record sources from being accidentally

deleted. It also displays how other objects are affected by the design change whenever any change is made in the design of an object.

QUESTION: 4
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Mark the option that you will choose to move all sides of selected controls in or out to meet the nearest point on the grid.

Grid
T 6nd
= Ruler

H  Snapto Grid

Grouping

IE'_' ngroup

Explanation: The various commands available in the Size and Ordering group that are helpful in arranging the controls are as follows:

s To Fit: Itis used to adjust control height and width for the font of the text.

+ To Tallest: It is used to make selected controls the height of the tallest selected control.

+ To Shortest: Itis used to make selected controls the height of the shortest selected control.

+ To Grid: Itis used to move all sides of selected contrals in or out to meet the nearest point on the grid.
+ To Widest: It is used to make selected controls the width of the widest selected contral.

« To Narrowest: [tis used to make selected controls the height of the narrowest selected contral.

QUESTION: 5

You are working on an Access form named Form-A. You have opened Property Sheet to view the form's properties and make the required
changes. Property Sheet consists of five tabs with a different set of properties. Which of the following tabs specifies how a value is
displayed and the data source is bound to control source, input mask, validation rule, default value, and other data type?

@ A: Data
© B: Format
© C Other

' D: Event
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Explanation: Answer option A is correct.

The Data tab of Property Sheet specifies how a value is displayed and the data source is bound to control source, input mask, validation rule,
default value, and other data type.

Property sheet x
Selection type: Form
Form j
Format Dats | Event | other | an |
Record Source Products
Recordset Type Dynaset =
Fetch Defaults Yes
Filter
Filter On Load Mo
Drder By
Drder By On Load Yes
‘Wait for Post Processing Mo
Data Entry Mo
Allow Additions es
Allow Deletions Ves
Al Edits Ves
Allowy Filters Yes
Record Locks Mo Locks
Fact What are the various tabs of the Property Sheet? Hide

The various tabs of the Property Sheet are as follows:

Format: It specifies how alabel or value is displayed. Itincudes font, size, border, spedial effect, and scroll bar.
Data: It specifies how a value is displayed and the data source is bound to control source, input mask, validation
rule, default value, and other data types.

« Event: It displays all events in the form of a call to a macro or a VBA procedure.

Other: It displays additional characteristics of contral, such as control name and description.
s All: It displays all properties of control.

QUESTION: 6

Which of the following view types allows & user to manipulate data on the form created in Access 20107

& A: Form view
© B: PivotChart view
7 (: Datasheet view

D PivotTable view
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Explanation: Answer option A is correct.

The Form view is a default view type for an Access form. It allows a user to manipulate data on the form.

| Home I Create External Data Database Toals (A 0
= B4 2l ¢~ |_— = 3 ﬁ & A
[—=]
P T-I I:{a Filt %l E- R|1@h =5 ? Find i Text
iz aste ilter efres S ind
2 3] F ';}__, W all> K- E & = | Formatting =
“Wiews | Clipboard & Sort & Filter | Records | Find | |
All Access Objects (¥ « || =] Details
. g
T 2 Products 5
Tables T e —
5 produds
Forms o D
G Check17
Product Car i
Mame
Price Detall  |$20,000.00
Product ID 23345 L
Order 1D lag . v
Record: M4 4+ 1of16 LA | bs':-| % Mo Filker |1Search

Answer option Cisincorrect. The Datasheet view displays the datain the table format.
Answer option B is incorrect. The PivotChart view allows a user to display the data of a form as pivot charts.

Answer option D is incorrect. The PivotTable view allows a user to display the data of a form as a pivot table.

QUESTION: 7
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You have a form named Annexure-1 created in Microsoft Office Access 2010. You have to split a cell horizantally into two smaller cells. The
cell has a control. You want the control to be moved to the left cell of the two resulting cells. Which of the following steps will you take to
accomplish the task?

' A: Design > Tools > Merge / Split > Split Horizontally
% B: Arrange > Rows & Columns > Insert Left
@ C: Arrange > Merge / Split group > Split Horizon tally

© D: Format > Selection > Rows & Columns > Split

Explanation: Answer option Cis carrect.

In order to accomplish the task, you should take the following steps:

Arrange > Merge / Split group > Split Horizontally

When you split a cell that has a control, the control automaticaly moves to the left cell of the two resulting cells.
Answer option B is incorrect. You can take these steps to add a new column to the left side of a specific column.

Answer options A and D are incorrect. The Design and Format tabs do not contain the options for splitting cells.

QUESTION: 8

You are wor<ing on a home computer with Microsoft Office 2010 installed on it. You have created some database files using MS O%fice Access.
You wan L Lu manage all your database Cles and cuslomize Lhe program. Inoorder Lo perfunm Lhis lass, you need Lo display Lhe Backs lage view,
Choose the tab that you will dick on the program window to display the Backstzge view.

Homz Create External Zata Databzse Toals

= save

Available Templates
L save Objeck s

Explanation: In order to cisplay the Backstage view, you should dick on the File tab in the upperdeft corner of the program window. The
Backstage view of MS Access 2010is shown in the image given below:

P
?mm External Cata Database Tools a!
-

Avallable Templates Blank database

ﬁ 2} Home
5 oper |
4 T[T

— e

Blank Blank web Recent Bad(stage

database database ternplites View

Recent

B = & :

! rint Sample My temnplates

templates

| Cffice.com Templat..  “ewch Office.cont &

|

| Help

| [

e ™= el LH
e

@ e el Aoty ook
ety ontacts ;::[I, £ .

L a S
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Fact What is the Backstage view? Hide

The Backstage view is a full-screen user interface model in which commands related to managing M5 Access and Access
database are arranged in the form of buttons and pages. The File tab in the upper-eft comer of the program window
displays the Backstage view. The Backstage view allows a user to create, save, and check hidden metadata or personal
information. It also helps in discovering and using the features that are not related to the authoring features on the
Ribbaon.

QUESTION: 9

You are working on a home computer with Microsoft Office 2010 installed on it. You have created a table named Table1 in Microsoft Office
Access 2010, Table! contains a sub-datasheet named Datasheet!. You want to waork with contents of this table in Excel 2010. In order to
perform this task, you need to export the table. Which of the following actions will MS Access perform while exporting the table from Access
to Excel?

 A: It converts the table into an HTML table.
© B: It creates a copy of the table and stores the copy as a SharePoint list.
% C: It creates an RTF document.

@ D: It exports only the main datasheet.

Explanation: Answer option D is correct.

When you export a table from Microsoft Office Access 2010 to Excel and the table contains a sub-datasheet, it exports only the main
datasheet. To export the sub-datasheet, you should perform another export operation. In order to combine multiple Access objectsintoa
single Excel workbook, you should export individual objects to different workbooks, and then merge all worksheets from within Excel.

Answer option Cisincorrect. Microsoft Office Access 2010 creates an RTF (Rich Text Format) document if you export information from
Access to Word. This RTF document can be opened by Word and various other applications.

Answer option A is incorrect. Microsoft Office Access 2010 converts a table into an HTML table if you export the table from Access to an
HTML file.

QUESTION: 10

You have created a database named Databasel using Microsoft Office Access 2010. You want to add an application part to the database to

extend the database functionality, Choose and re-order the steps that you will take to accomplish the task.

" Correct Answer ' Your Answer
Required steps Steps
;J;l Save it as an object using the 'Save & Publish' button.
Click the OK button.
Fill information required to set for parts,
;];l Save it as a template using the 'Save & Publish' button.
Strip a database down to the objects that are required in

Get Latest & Actual IT Exam Dumps with VCE and PDF from Pass4itSure.
https://www.Pass4itSure.com



O Instant Download 0 PDF And VCE O 100% Passing Guarantee [0 100% Money Back Guarantee

Explanation: Take the following steps to create an application part in Microsoft Office Access 2010

1. Strip a database down to the objects that are required in the part.

2. Saveit as a template using the Save & Publish' button.

Database fie Typts
(B 2ecens Ditabine "accam)

D 4 drtaPare besmit

B acce

W Paciageand S
Fachmn That dalabana sed a0ty 8 Sptal

Lret e ablaned
deabrie The nre loc ditsbne ad b
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3. Fllinformation required to set for parts.

Diama:

m:

Primary Table:
I =]

tfuhmlltim Form:

[7] appication Part
[7] Indyde Data in Template

4, Click the OK button.

Fact ‘What is an application part? Hide

An application part is a template available in Microsoft Office Access 2010. It can be added to an existing database. It is
used to extend the functionality of an Access database. It can incdude only a single table or a number of database objects,
such as tables, forms, reports, and even relationships. A user can open up the Application Parts gallery in order to view
the built-in parts.

QUESTION: 11
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You are creating a report named Performance in Microsoft Office Access 2010 using the Report Design feature. This feature opens a report

layout in the Design view. Which of the following tasks can you performin the Design view?

Each correct answer represents a complete solution. Choose all that apply.

7 A: Add fields from the Field List.
[N B: Adjust the report elements' properties.
[N C: Adjust the size of sections of design grid.

[N D: Add and manage contrals.

Explanation: Answer options C, B, and D are correct.
The following tasks are performed in the Design view of an Access report:
+ Apply a new theme.
« Adjust the size of sections of design grid.
+ Add contrals.
+ Manage controls.

+ Adjust the report elements' properties in the Property Sheet.

Answer option Aisincorrect. You can perform this task when you are working with an Access form.

QUESTION: 12

James works as a Database Designer for Tech Perfect Inc. He has to create a query that will extract the name and address of each customer

who has made more than one order. Which of the following Query wizards should he use to accomplish the task?

& A: Find Unmatched
 B: Crosstab
C: Simple

@ D: Find Duplicates

Explanation: Answer option D is correct.

In order to accomplish the task, James should use the Find Duplicates Query wizard. This wizard is used to set up a query in order to locate

records. These records contain the same data in one or more specified fields.

Answer option Cisincorrect. He can use the Simple Query wizard to extract the name and address of each customer who has ever made an

arder.
Answer option Aisincorrect. He can use the Find Unmatched Query wizard to locate the customers who do not have made any order.

Answer option B is incorrect. He can use the Crosstab Query wizard to calculate and re-organize data for making the analysis easy.

QUESTION: 13
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James woarks as a Datakase Designzr for Tzch Perfect Inc. He wants to prevent the Navigation Pane from appearing by defzult 'n Microsoft
Office Access 2010. Whch of the following steps will James ake to finc the option for this task?

% A: New > Oplions » Cutrenl dalabase
© B: Home > Vizw > Options
2 Darabase Tools > Nptions > Access Natahase

# D: Create > Options > Templates

Explanation: Answer option Ais correct.

James will take the following steps to find the option fo- the given task:

New > Options > Current database

Home Create External Data Database Tools

A Save ;
= Information about Database3

CA\Documents and Settingshpriyanka\My Documents\Databas

[ (3] save Database As }

(L7 Open T REMOYE PETSUTET MITOTITatoTT
General .
[ Close Database ¥ Use Windows-themed Contro
| Current Database | v Enable Layout View
EE)J Databasel.accdb [¥ Enable design changes for tat
Datasheet

¥ Check for truncated number f
Object Designers Picture Property Storage Format
@1] Databasel.accdb ® Preserve source image forr

Proofin
(@] Databasel.accdb kit " Convert all picture data to
: ' fanguage Access 2003 and earlier]

c“ent Settlngs Na‘"ga“un

Recent Customize Ribbon v Display Navigation Pane
MNavigation Options... I

(3] Employees.accdb

Quick Access Toolbar

Mew
Add-ins Ribbon and Toolbar Options
Print Trust Center Ribban Nare: I 1,I
—
Save & Publish 4
Help

I 2] Options I

Answer options B, C, and D are incorrect. These are not valid steps to find the option for the given task.
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QUESTION: 14

James works as a Database Designer for Tech Perfect Inc. The company has a Windows Vista-based computer with Microsoft Office 2010
installed on it. The computer has a database named Accounts and two tables named Table1 and TableZ, which are created in Microsoft O
Access 2010, James wants to apply referential integrity to establish a relationship between these tables. Which of the following are requ
to accomplish the task?

Each correct answer represents a part of the solution. Choose three.

[N A: The related fields contain the same format.
I B: Table1 and Table2 are related to the same database.
7 C: The related field must have different formats.

¥ D: The common field is the primary key of the primary table.

Explanation: Answer options D, A, and B are correct.
The following are required for establishing referential integrity between two tables:

e The commaon field is the primary key of the primary table.
* The related fields contain the same format.
« Both tables are related to the same database.

Answer option Cisincorrect. In order to establish referential integrity, it is required that both tables have the same format.

QUESTION: 15

Which of the following types of query is commonly useful when queries are used as the basis for a report that is run periodically, but with
different values at different times?

& A: Parameter query
© B: Select query
© C: Crosstab query

© D: Action query

Explanation: Answer option A is correct.

A parameter query prompts a user for information to be usedin the query. For example, a range of dates. This type of query is commanly

useful when queries are used as the basis for a report that is run periodically, but with different values at different times.

Answer option B is incorrect. A select query is a simple type of query thatis commonly used in Microsoft Office Access 2007. This query
retrieves data from one or more tables and displays the results in a datasheet. A user can use a select query to group records and calculate
sum, counts, averages, and other types of totals. The user can also work with the results of a select query in the Datasheet view to update
records in one or more related tables at the same time.

Answer option D is incorrect. An action query is used to update multiple records in one operation. It is a form of select query that performs
an action on the results of the selection process. There are four types of action queries available in Microsoft Office Access 2007, which are
as follows:
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1. Delete queries: A delete query allows to delete records from one or more tables.

2. Update queries: An update query allows to modify fields. This is used to update a field with an expression or data from another
table.

3. Append queries: An append query allows to add records from one or more tables to the end of one or more ather tables.

4. Make-table queries: A make-table query allows to create a new table from all or part of the datain one or more tables.

Answer option Cisincorrect. A crosstab query is a powerful analysis tool used to see the relationship of data between two fields. It
calculates and restructures data for easier analysis. A user can use a crosstab query to calculate a sum, average, count, or other type of total
for data that is grouped by two types of information- one down the left side of the datasheet and one across the top. The cell at the
junction of each row and column displays the results of the query's calculation. This view is just like a spreadsheet with unique values of one

field as rows, unique values of another field as columns, and the summary of ancother field as the cells in the matrix.

QUESTION: 16

You work as a Databasc Des gner for Tech Perfect Inc. The company has a Windows Vista bascd computer with Microsoft Offiec 2010 installed
on It. You wart to ensure that the databases created 10 Microsoft O*fice Access 2010 seve in the Microsoft Access 2003 “ormat. Which of the
follawing options will vou choosein the Access Options dialog box to accomplish the task?

© A: Client Settings

B Current Database

' (; Dbject Cesgners

% D: General

Explanation: Answer option Dis correct.

In arder to accomplish the tas<, you will choose the Genera option in the Access Options dialog box. This option opers a page that includes
the Default file format drop-down list as show in the image given below:

Access Options
General l I ; : =
- @ Genera oplions for working with Access,
Current Database
Datashzet User Inlerface options
Chject Designers ¥ Enable Live Previzw
) W mhways use Clearlype
Proafing
ScreenTip style: |Show feature descriptions in ScreenTips ;l
Language F show shortout keys in ScreenTips
Client Settings Color scheme: |Siluer v’
Customize Ribbon Creating databases
i Toaol —
Qi AcpessTanibne Defauit file fomnat for Blank Database: [Access 2007 =
i Derau pocesrzon |
database  |CiDocuments and Setting s STy \ Browse
elac oot
Trust Center older s ccess 2007
New database sort crder! SETTErdT= LRG0
Personalize your copy of Microsaoft Office
User name: [user
Initials: |L -
q |
| oK I Cancel I
p

Get Latest & Actual IT Exam Dumps with VCE and PDF from Pass4itSure.
https://www.Pass4itSure.com



O Instant Download 0 PDF And VCE O 100% Passing Guarantee [1 100% Money Back Guarantee

You can ciarge the format of any of the previous versions of Microsoft Access.

Answe- option 3 is incorrect. The Current Datadase optonindudes the settings for the currently used database.

a
zereral . - .
0 | , Dptions for the cu-rent catzbase,
Zurent Database
Jatashzet Application Options
Jhject Designars Application Title |

Aroofing Application | Erauwwze,., |
Turi

[T Uie as Ferm and ResortIecn

.angjuage
Lispilay Farm -
Clieat Settings plpl I —I
Wb Display Fom: I LI
Zuskarrize Ribaor [T Display Satus Bar
Duizk Access Toolbar Documert Windomw Cptions
[ Drerlapping Wind o
Adec-ing & Tahbed Cocuments

- Display Document Tabs
[T Use Access Saecil keys (D
- LCompacton Close
r Remowe personal infornatian from file properties on save j

Trust Center

Answer option Cisincorrect. The Object Designers option changes the defoult settings of datakbase object’s design.

Access Dptions KHE

|h"1 Change the defaull setlings for design of dalabase =
== objeds, Most oglions are ignored in table datasheet a..

General

Current Databasa

Datashest Table design view
Objeck Designer: Drerault Meld type: Text hd
Proofing Default t2uct field size: 255 —

Default pumber field size Ilong Integer = I

Autolrdex on ImportsCreaste |ID;|:ey,'coce;num
¥ Show Property Update Options buttons

language

Client Settings

Customize Ribban
Query design
Quick Access Toclbar
W Show table names

Add-ins [ Qutput all fields
Trust Center W Enable AutoJoin
Query design font
Eont: ISegae 1)1 _;I

Size: |a vi _"'I
| oK I Cancel I

e

Answer option Ais incorrect. The Client Settings option includes the settings that change the dient behavior.
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Answer option Aisincorrect. The Client Settings option incdudes the settings that change the dient behavior.

General !_. Settings that change the client behavior. These are user
° settings that don't move to the web experience.

7

Current Database

Datasheet Editing

Object Designers hove after enter
 Don't move

Pracfing & pext field

Language o Mext recard

Eehavior entering field
E {s select entire field
Custamize Ribbon ' Goto start of field

¢ Goto end of field

Qick Access Toolbar Arrous key behavior

Addeins & pext field
" Mext character
Trust Center - Cursor stops at firstflast field

Default findsreplace behavior
o Fast search
™ Canaral caurch _vl

Ok I Cancel |

F

You waork as a Database Designer for Tech Perfect Inc. The company has & Windows Vista computer on which Microsoft Office 2010 is
installed. The computer has a database named Sales created in M5 Access 2010. You do not want to lose valuable data even when your
computer encounters a problem. In order to save the data, you have to make backup copies of your database on a regular basis. Choose and

re-order the steps that you will take to accomplish the task.

" Correct Answer Your Answer
Required steps Steps
._J,;J Choose a location for the back up copy.
Click the Back Up Database option.
Specify a2 backup name.
;JA_J Click the Save As button,
Click the Save & Publish button,
Click the Save button,
Select the Save Database As option.
Click the File tab.
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Explanation: Take the following steps to back up an Access database:

1. Save and close all objects in the database.

2. Click the File tab and then click the Save & Fublish button.

File Harme Create E:
@,j Dratabase3.accdb

IEH';'I Databasel.accdb

@ Databased.accdb

Info
Recent
R [=1T)

Print

Save & Publish

Help

lﬁ Options

3. Select the Save Database As option.
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File Types
% Save Database As

-.._l Cave ':'|.'-_il?t"-'. B

Publish

ﬁ Publish to &ccess Services

4, Click the Back Up Database option and then dick the Save As button.

External Data Database Tools £ o
Sawe the current database as a datahase [
ternplate (ACCOT), [

Advanced

Package and Sign
Package the database and apply a digital
sighature,

< Make ACCDE

File will be compiled into an executable
|
[

Ea
orevent data loss:

- SharePaint
Share the database by sawing itto a
document management senser,

Save D [

{w| |

e _»]

9. Click the Save in list arrow to choose alocation for the back up copy.

6. Specify a different backup name and then dick the Save button.
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Save As ﬂm
savein: [ (L) My Documents N = @-3 X
s My Recent  [F]patabase!
Documents  Yilpatabase2

(& Deskton 1 Databases

W . [Aemplayees Choose the location
i My,
I pocuments |
= M
ac;wmer
My Metwark:
~:;PI;:ES r
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QUESTION: 18

Which of the following options is used to package, digitally sign, and distribute a database in the .accdc file format while sharing an Access
database file?

" A: SharePoint
 B: Make ACCDE
' C: Access Services

@ D: Package and Sign

Explanation: Answer option D is correct.

The Package and Sign option is used to package, digitally sign, and distribute a database in the .accde format. All users will be able to extract
the database from the package and work directly on the database. If you share the modules with other users, you should convert the
database file to the .accde file format.

Answer option B is incorrect. The Make ACCDE option alows Access to remove the editable source code and compacts it into a smaller and
more optimized database.

Answer option Aisincorrect. The SharePoint option allows you to synchronize file content with SharePoint ibraries.

Answer option Cisincorrect. The Access Services option allows you to publish the database to the server and use the database in a Web
browser.
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QUESTION: 19

Which of the following is located along the left side of the Access screen and provides an interface for all database objects?

© A: Application part
7 B: Quick Access Toolbar
@ C: Navigation Pane

' D: Object Dependencies pane

Explanation: Answer option Cis correct.

The Mavigation Pane provides an interface for all database objects, such as tables, queries, forms, reports, macros, and modules. |t is located
along the left side of the Access screen. In the Navigation Pane, all items are organized into groups. It is also used to show or hide the

database objects.

Answer option B is incorrect. The Quick Access Toolbarin MS Access 2010 is a customizable toolbar which is displayed in the title bar of the
Database window. It has a set of commands or functions (save, undo/redo, and print) that are independent of the tab on the ribbon
currently displayed in M5 Access. The Quick Access Toolbar can be moved from ane of the two possible locations. A user can add any Access

command as a button to the Quick Access Toolbar.

Answer option D is incorrect. The Object Dependencies pane is available on the Relationships group in the Database Tools tab. It
demonstrates the interactions or dependencies of all database objects. It helps in preventing record sources from being accidentally
deleted. It also displays how other objects are affected by the design change whenever any change is made in the design of an object.

QUESTION: 20

You work on & home computer with Microsoft Office 2010 installed on it. You have created a database named Database3 using Microsoft
Office Access 2010. This database contains four Access objects named Employee, Employee query, Customer data, and 5Sales report. You

want to view these objects in the Navigation Pane. Which of the following options will you choose to accomplish the task?

 A: Navigate To Category
' B: Filter By Group
 C: Custom

@ D: All Access Objects
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Explanation: Answer option D is carrect.

In order to accomplish the task, you should choose the All Access Objects options in the Mavigation Pane. It displays all Access objects
included in Database3 as shown in the image given below:

W .
" — — Al Access Objects ® «
Navige |Search.‘. | Fel
Custam e .
CHlEtlne E Employee
Tables and Related Wiews Queries PS
Lreated Date @ Employee query
Modified Date ﬁﬁrms ES
fijﬁ&_ﬁy:&nqp .m"C"ustomer data . a
Tables Reports E
Queties Ml sales repart
Earms
Beports

Al Actess Objects
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QUESTION: 21

You work as a Database Designer for Tech Perfect Inc. The company has a Windows Vista-based computer with Microsoft Office 2010 installed
on it. The computer contains a database named Products created in Microsoft Office Access 2010. You are adding the application part
template to the database. You want to apply a setting that displays the template both in the Access Getting Started place and in the
Application Parts Gallery. Which of the following actions will you take to accomplish the task?

© A: Choose a primary table.
© B: Choose an appropriate categary.
 C: Check the Include Datain the Template check bax.

@ D: Check the Application Part check box.

Explanation: Answer option D is correct.

In order to accomplish the task, you should check the Application Part check box. You can view the template in the Access Getting Started

place and in the Application Parts Gallery when this check box is checked.
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Answer option B is incorrect. It determines which section of the Application Parts Gallery is displayed in your part.
Answer option Cisincorrect. It saves the current set of table data with the template.

Answer option Aisincorrect. It allows Access to launch a relationship wizard that helps you in connecting the part to the rest of your

database.

QUESTION: 22

You work as a Database Designer for Tech Perfect Inc. The company has a Windows Vista-based computer with Microsoft Office 2010 installed
on it. The computer contains two databases named Shippers and Orders created in Microsoft Office Access 2010. A one-to-many relationship

is created between both tables. You want to delete a Shipper. The shipper that you want to delete has orders in the Orders table. When you
delete the Shipper record, these orders will become "orphans”. The orders will still incdude a shipper ID, but this ID will not be valid. What will
you do to prevent these orphans?

' A: Cascade update related fields.
' B: Enforce domain integrity.
© (2 Cascade delete related records.

@ D: Enforce referential integrity.

Explanation: Answer option D is correct.

To prevent these orphans, you should enforce referential integrity. Referential integrity means that the foreign key in any referencing table
must always refer to a valid row in the referenced table. Referential integrity ensures that the relationship between two tables remains
synchronized during updates and deletes. For a foreign key to be valid, it must contain either the value NULL, or an existing key value from
the primary or unique key columns referenced by the foreign key. To enforce referential integrity, a foreign key column link to the primary
key column should be created in the related table.

Answer option A is incorrect. You can cascade update related fields to update all affected rows as part of a single operation.

QUESTION: 23
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You work as a Database Designer for Tech Perfect Inc. The company has a Windows Vista-based computer with Microsoft Office 2010 installed
on it. The computer has a number of projects. You are required to create a table in Microsoft Office Access 2010 for tracking all projects that
are required to be completed. Mark the option that you will choose to accomplish the task.

=t=RullT-
= ] =]
Table Table SharePoint | Queny CQun
Desighn Lists = Wizard Desi
= ==
[T (===
1Top 2Tap
| —
= En
Dialog Media
Msghios Tabs
Quick Start
Comments  Contacts Issues Tasks
Users

Explanation: In order to accomplish the task, you should choose the Tasks option. It is available in the Quick Start category as shown in the
image given below:

B =& m
Application| Table Table SharePoint | Query Quo
Parts » Design Lists = Wizard Desi
Blank Forms

1 Right

El

L
Details

I_—I
Msgho
Quick Start

Comments Contacts Issues

3

Users

L
2 Right

List

The Tasks option is used to track various tasks and projects that are required to be completed. This option creates a Tasks table and two
forms. Key fields of this table have start and due dates for the task and percentage of task completed.

The Tasks option is used to track various tasks and projects that are required to be completed. This option creates a Tasks table and two
forms. Key fields of this table have start and due dates for the task and percentage of task completed,

QUESTION: 24
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You work as a Database Designer for Tech Perfect Inc. The company has a Windows Vista-based computer with Microsoft Office 2010 installed
on it. The computer has a database named Customers created in Microsoft Office Access 2010. You want to find al customer records where
the contact person's title is Owner and the person is located either in Portland orin Eugene. Which of the following filter features will you

use to accomplish the task?

' A: Advanced Filter
' B: Filter By Record
' (C: Filter By Selection

@ D: Filter By Form

Explanation: Answer option D is correct.

In order to accomplish the task, you should use the Filter By Form feature. The Filter by Form feature is used to filter records based on the
values in fields of a table, query, or form. It displays a filtering datasheet with blank fields. Each blank field is a combo box that contains a list
of all the entries made in those fields. A user can select a value from this list or enter a new value. It is easy to use the Filter by Form feature
when a table contains only a few fields.

Answer option Cisincorrect. The Filter by Selection feature is used to filter records based on the current selection in a field.

Answer option Aisincorrect. The Advanced Filter feature is used to create a simple query on a single table.

Answer option B is incorrect. There is no such feature as Filter by Record in Access 2010.
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QUESTION: 25

In which of the following views does the program window open when a user starts Microsoft Office Access 2010 without opening a database?

 A: PivotTable view
" B: Design view
© C: PivotChart view

& D: Backstage view

Explanation: Answer option D is correct.

The program window opens in the Backstage view when a user starts Microsoft Office Access 2010 without opening a database. The
Backstage view is a full-screen userinterface model in which commands related to managing M5 Access and Access database are arranged in
the form of buttons and pages. The File tab in the upper-left corner of the program window displays the Backstage view. The Backstage view
allows a user to create, save, and check hidden metadata or personal information. It also helps in discovering and using the features that are
not related to the authoring features on the Ribbon.

Answer option Cisincorrect. The PivotChart view of a table can be used to display the data of a table in the desired format using a graph.
This view cannot be used to create or delete a field or modify its properties. The data can be filtered according to fields. When the
PivotChart view is opened, a blank work area is displayed and the columns of the table are displayed in the Chart Feld List window. A user
has to drag and drop the fields to view the desired result. The PivotChart view uses an Office Chart Component and helps a user to create
dynamic and interactive charts.
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Answer option Aisincorrect. The PivotTable view of a table can be usad to display the data of a table 'n the desired format. This view
cannot be used to ercate or delete a field cr modify its propertics. The datz can be filtered according to ficlds. When the PivotTable viewis
openzd, a blank work area 's displaved and the columns cf the table are displayedin the Fivot Takle Fleld List window. & uvser has to dreg anc
drop the fieles to view the desired resulz.

* Group || 2 | BowitnFitter @ %
@ Lingraup

\'@ Show Top/Bottom = || Refresh Export
Fivot to Fxcel

' Crop Filter Fiel ds Here
Drop Column Fields Here

Drop Row Fields Here

Drop Totals or Detail Fields H

| - ==
Answer gption Bis incorrect, The Design view of a table displays its fields and datatypes. New fields can be addec to the table and assigned

to a datatype. A user cannot insert data in this view. The datatype of a field can be formatted and other table properties such as field size,
validation rule, etc., can be set for the fiald.

Fielc Properties

A field name can be up to 54 characters long,
including spaces. Prexs FL or help on lield
names,

Caption

Walldation Text
Required
Indexed

Tk oan

QUESTION: 26

You work as a Database Designer for Tech Perfect Inc. The company has a Windows Vista-based computer with Microsoft Office 2010 installed
on it. The computer has a database named Details. The database contains several tables. You open a table named Staffs which contains all
information about employees working in 1997, The structure of the table is given in the image below:
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Field Mame | Data Type | Description
'_iID AutoMNumbzar
. Employee Namel Text
| Department Text
iAddress Teut
city Text
|State Text

‘ Rl

Field Properties

General Il_ookupl
Field Sze 255 -
Fermat |
Inout Mask
Caption
Default Value
zlidation Rule A field name can be up to £4 characters long,
elidation Text including spaces. Press F1for help on field
Requirzd Mo names.
Allow Zero Length Yes
Indexed No
Unicoce Compression  Yes
IME Mode No Contral
IME Sentence Mode None |
Smart Tags ;I

Now, you want to delete this table frcm the database. You get an error while deleting the table. Which of the following is the most likely
cause of the error?

Mow, you want to delete this table from the database. You get an error while deleting the teble. Wkich of the following is the mest likely
cause ot the error!

% A: The teble is connected with another table.
© B: The tzble does not have a primary key.
@ C: The teble is opened in the Design view

# D: The teble uses referential integrity.

Explanation: Answer opticn Cis correct.

The cause cf the erroris that the table i opened in the Design view. When a table is opened in the Design view, the Datasheet view, the
PivotChart view, or the PivotTable view, it cannot be deleted. In crde- to delete the table, all views must be cosed.

Answer opton Aisincarrect. A table can be deleted successfully wher it is connected to two or more tables.
Answer opton Bisincorrect. A tzble can be deletec successfully even if it contains a primary key.

Answer opton D isincorrect. A table can be deleted successfully wher it uses referential integrity.
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QUESTION: 27

You have a table named Projects created in Microsoft Office Access 2010. You are required to make some changes in the table's data. In
which of the following views will you open the table to accomplish the task?

 A: PivotChart view
© B: Datasheet view
© C: PivotTable view

© D: Design view

Explanation: Answer option B is caorrect.
You should open the Projects table in the Datasheet view to make some changes in the table's data.

The Datasheet view is the default view of a table. It is used to display and maodify data of the table. When a table is opened in the Datasheet
wiew, this wiew displays the table's datain columns (fields) and rows (records). The first row has column headings or field names. In order to
open a table in the Datasheet view, a user should double-click on the table's name or choose the Datasheet View option from the view list.

The Datasheet view of a table is given below:

Home Create External Data Database Tools ‘ Fields | Table 'a e

MR EET 2 =
=l A Formatting - =
View Text Mumber Currency . Properties T Field
- ﬁ' - $ % v e 25 |\Validation~|
Views | Add & Delete | Formatting |

Tables & « blel x
frn e - ookName - - clok
T Tabler

[Record: 0« 1072 | » M Wi | % NoFiiter

Search

Answer aptions C and A are incorrect. In the PivotTable and PivotChart views, you can perform data analysis. Both of them are used to
organize and summarize information into useful analysis presentations.

QUESTION: 28
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Which of the following are the benefits of specifying a primary key for a table in Microsoft Office Access 20107

Each correct answer represents a complete solution. Choose all that apply.

N A: MS Access ensures that each record consists of a value in the primary key field.
[N B: MS Access ensures that each value in the primary key field is unique.
[N C: MS Access improves the database performance.

7 D: MS Access restricts the data type, valid values, and range of possible values for columns in a
table.

Explanation: Answer options C, A, and B are correct.
The various benefits of specifying a primary key for a table are as follows:

* M5 Access improves the database performance by automatically generating an index for the primary key.
* M5 Access ensures that each record consists of a value in the primary key field.

* M5 Access ensures that each value in the primary key field is unique.

Answer option D isincorrect. Domain integrity enforces data validity by restricting the data type, valid values (using CHECK constraints and
rules), and range of possible values (using FOREIGN KEY constraints) for columns in a table.

QUESTION: 29

You have two tables named Customers and Orders created in Microsoft Office Access 2010. In Orders table, each order has a customer ID. You
want to correspond it to a record in the Customers table. Which of the following will you use to accomplish the task?

Each correct answer represents a complete solution. Choose all that apply.

7 A: Entity intearity
N B: Foreign key
I C: Primary key

7 D: Domain integrity

Explanation: Answer options C and B are correct.

In order to accomplish the task, you should use the following:

» Primary key: A table usually has a column or combination of columns whose values uniquely identify each row in the table. This
column (or columns) is called the primary key. Primary key ensures that no duplicate or null values are entered in the column (or
columns) defined as primary key columns. This enforces integrity of the table. A primary key can be created by defining a primary key
constraint while creating or altering a table. A table can have only one primary key constraint. As primary key constraints ensure

uniqueness, they are often defined by using an identity column.
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» Foreign key: A foreign key is a column or combination of columns used to establish and enforce a relationship between the datain
two tables. This relationship is created by adding a column(s) in one of the tables to refer to the other table's column(s) protected by
a PRIMARY KEY or UNIQUE constraint. This column becomes a foreign key in the first table. A foreign key can be created by defining a
FOREIGM KEY constraint when creating or altering a table.

Answer option Aisincorrect. Entity integrity enforces the uniqueness of rows in a table. The uniqueness of rows can be enforced by the
identifier column(s) through indexes, UNIQUE constraints, PRIMARY KEY constraints, or IDENTITY properties.

Answer option D is incorrect. Domain integrity enforces data validity by restricting the data type, valid values (using CHECK constraints and

rules), and range of possible values (using FOREIGN KEY constraints) for columns in a table.

QUESTION: 30

You work as a Database Designer for Tech Perfect Inc. The company has a Windows Vista-based computer with Microsoft Office 2010 installed
on it. The computer has a database named Institutes created in Microsoft Office Access 2010. You want to import a word document named

Students to an Access file named Library. What will you do to accomplish the task?

© A: Choose the Word Merge option from the Import & Link group.
' B: Copy and paste the word document to the destination file.
¥ C: Link the word document to the Access file.

@ D: Save the document as a text file and then import it.

Explanation: Answer option D is correct.

In order to accomplish the task, you should save the word document as a text file and then import this file from the Import & Link group. You

cannot directly import a word document to an Access file.

Answer option A is incorrect. There is no option for importing a word document in the Import & Link group. The Word Merge option is

displayed in the Export group.
Answer option B is incorrect. You cannot import & word document by this way.

Answer option C is incorrect. Access does not allow linking a word document.

QUESTION: 31
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You work as a Database Designer for Tech Perfect Inc. The company has a Windows Vista-based computer with Microsoft Office 2010 installed

on it. The computer has a table named Products created in Microsoft Office Access 2010.

In} ~ |Product Marr » | Price Detail «1 | Product 1D~ OrderlD -

| 7 Truck 542,000,00 23346 9864
| & Truck 440,000,00 23349 7654
|| 10 Truck £28,000,00 23358 Te23
| 8 Truck 536,000.00 23352 6512
| 4 car 435,000,00 23360 7765
| 9 Truck £33,000,00 23356 3567
| 2 Car 430,000.00 23348 9985
| 5 Car 428,000,00 23355 5432
| 3 Car 425,000,00 23350 8892
| 1 Car 420,000.00 23345 9957
| 12 Bike 515,000.00 23353 1209
|| 15 Bike $14,000.00 23354 8530
|| 14 Bike £12,000.00 23347 9025
11 Bike 510,000.00 23351 5643

© 1seke  ssOon00 23887 2365

You want to rearrange all products so that the table displays product's price list in the decreasing order. Mark the tab/button that you will

choose to accomplish the task.

%Lﬁ.sc&nding \_f} Selection =

k. |i.[. Descending |¥Vo] &dvanced =
Filter
| i) Remowe Sort " Toggle Filter

Sort & Filter

Explanation: In order to accomplish the task, you should select the field consisting of the price list and then dick on the Descending button
in the Sort & Filter group.

? ending ¥ Selection - I_ =i Mew X Totals ﬂ 2. Repl
Ay Descending) 3] Advanced - = Save ¥ spelling ; = GoT
3 W Togale Filter Rgﬁejh X Delete » EMore » e lg sele
‘ Sort & Filter Records Find

1| - | Product Narr OrderlD -
il | L Car 23345 9987
gl 2 Car 23348 9385
18 3 Car 23350 8892
|| 4 Car 23360 7765
1) 5 Car 23355 5432
6 Truck 2334 7654
7] 7 Truck Sde?ataﬁg'e columy,
|| 8 Truck 23352 £512
1) 9 Truck 23356 3567
L1 10 Truck 23358 7623
|| 11 Bike 23351 5643
| | 12 Bike 23353 1209
13 Bike 23357 2365
11 14 Bike 23347 3025
|| 15 Bike 23354 8530
* (MNew)
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After dicking on the Descending button, the table displays product's price list in the decreasing order.

1D - Product Mam ~ | Price Detail - Product D~  OrderlD -

|| 7 Truck 542,000,00 23348 9864
|| & Truck 540,000,00 23349 7654
|| 10 Truck £39,000.00 23358 Te23
|| g Truck $36,000,00 23352 £512
|| 4 Car £35,000,00 23360 7765
|| 9 Truck £33,000.00 23358 3567
|| 2 Car £30,000,00 23348 9985
|| 5 Car §28,000.00 23355 5432
|| 3 Car £25,000.00 23350 8892
|| 1 Car £20,000.00 23345 9987
|| 12 Bike 815,000.00 23353 12089
|| 15 Bike 514,000.00 23354 8330
14 Bike 512,000.00 23347 9025

11 Bike 510,000.00 23351 5643
-————

QUESTION: 32

You have alist of records where fields are empty in a certain column. You want to filter the list so that you get the non-empty fields only.
What will you do to accomplish the task?

Each correct answer represents a complete solution. Choose twao.

7 A: Click on an empty field in the column and choose the Equals Blank option from the Selection

menu.

[N B: Click on an empty field in the column and choose the Does Mot Equal Blank option from the
Selection menu.

7 C: Right-click on an empty field in the calumn and dick the Equals Blank option.

[N D: Right-click on an empty field in the column and dick the Does Not Equal Blank option.

Explanation: Answer options D and B are correct.

In order to accomplish the task, you will have to perform one of the following tasks:

+ Right-dick on an empty field in the column and dick the Does Mot Equal Blank option.
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| T
& | cut
2 | Copy

Paste

=a
&
| Sort smallest to Largest

— il Sort Largest to Smallest

=] Clear filter from Order I
Mumber Filters 3

Equals Blank
I Does Mot Equal Blank [

o Click on an empty field in the column and choose the Does Not Equal Elank option from the Selection menu.

i

cut

Lopy

Paste

Sort Smallestto Largest
Sort Largest to Smallest

[
E 8P

il Clear filter fram Order I0
Mumber Filters ]

Equals Blank
Does NotEqual Blank |

Both will display the non-empty fields only,

Answer options C and A are incorrect. When you perform any of these tasks, you will get the empty fields only.
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QUESTION: 33

Which of the following field properties allows you to enter a ™" stringin a field to indicate that there is no value for that field?

& A: Allow Zero Length
 B: Append Only
© C: IME Mode

© D: Input Mask

Explanation: Answer option A is correct.
The Allow Zero Length property allows a user to enter a zero-length (") string in a field to indicate that there is no value for that field.

Answer option B is incorrect. The Append Only property is mainly used for memo fields. When this property is set to 'Yes, it creates a field
value history to add new text to the field.

Answer option Cis incorrect. The IME Mode property is related to East Asian languages.

Answer option D is incorrect. The Input Mask property is used to specify that the field value should conform to the pattern set by the mask.

QUESTION: 34

You are working with Microsoft Office Access 2010. You have created two tables named Students and StudentCourses. You have established a
one-to-many relationship between both tables. You want changes made to the primary field of the StudentCourses table to be automatically
copied to the related field of the Students table. Mark the option that you will choose to accomplish the task?

Relationships

TableQuery; Related Table/Query:

l students ;istudent_coursas ;‘

Cancel
studentID _[studentID: = I
| 1 Join Type., I
Create MNew ..
1 Erforce Refsrential Integrity reate Hew I

| Cascade Update Related Fields |

[~ Cascade Delete Related Records

Relationship Type: One-To-Many |

Explanation: In order to accomplish the task, you should choose the Cascade Update Related Fields option. When you choose this option,

the changes made to the primary field of the StudentCourses table will be automatically copied to the related field of the Students table.

Get Latest & Actual IT Exam Dumps with VCE and PDF from Pass4itSure.
https://www.Pass4itSure.com



O Instant Download 0 PDF And VCE O 100% Passing Guarantee [1 100% Money Back Guarantee

Edit Relationships

Table/CQuery: Related Table/Guery: oF
| students ;Istudant_cnursas ;I

studentID = [ studentI0 I~

Cancel

Jain Twpe. .

Creakte Mew,,

1

| Enforce Referential Intearity

Relationship Type: | One-To-Many

QUESTION: 35

You are creating a form in Microsoft Office Access 2010. You want the created form to display a Form view and a Datasheet view of the same

data at the same time. Which of the following tools will you use to accomplish the task?

A MNavigation
© B: Multiple ltems
@ C: split Form

© D: Form

Explanation: Answer option C is correct.

In order to accomplish the task, you should use the Split Form tool. It is used to create a form that displays a Form view and a Datasheet

view of the same data at the same time.
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= DIEFDrmWizard
— [am]

ENauigatiDn i

Form  Form  Elank Report
Design  Form m

Forms

e=| Multiple tems
e

Datasheet

Split Form

Modal Dialog

e (i

PivotChart

PivotTable

Sl

QUESTION: 36

You have created a database by dicking the Blank Web Database button in the Microsoft Backstage view. Which of the following types of
view is available for designing forms?

 A: Form view
' B: Datasheet view
@ C: Layout view

D Design view

Explanation: Answer option Cis correct.

When a database is created by dicking the Blank Web Database button in the Microsoft Backstage view, only the Layout view is available for
designing forms.

The Layout view is used to modify a form in Microsoft Office Access 2010. In this view, the form is actually running. The Layout view displays
the data when the form is modified. This view is very helpfulin setting the control's size or performing other tasks that change the look and
usability of the form.

Answer option A isincorrect. The Form view is a common view of forms in which you can view and enter data as per your requirement.

Answer option D is incorrect. The Design view is a common view of form in which you can work with the elements of the form and refine
element's look and way of working. You can also add controls to the form through the Design view.

QUESTION: 37
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You have created a form named Details in Microsoft Office Access 2010.You want to add new elzments, change the header/footer, and apply
a new theme to the form. Which of the following tabs will you choose 1o accomplish the task?

© A: Hement

Explanation: Answer option Bis comect.

In order to accomplish the task, you should choose the Dasign tab lying in Form Layout Tools. You can add new elements, change the
heeder/footer, and apply themes to the form by using the Design tab.

n Home | Creste | EdemalData DatabaseTools || Design | Amange  Format o (7]

F_gl [B] Themes + % s M8i0co ;E

B cutons - B itre
WPt Cnrtrols t Add Fristing Prepe
- @Fmts' - Image ﬁDate and Time Fields Sheet
RUETE Themes | Controls Header / Focter Tools

Answer option Dis incorrect. The Arrangs tab has various layout options.

Answer optinn [ is incarrect. The Arrange tah has vadnas laynus aptinns.

Answer option Cis incorrect. The Format tak is usad to change the color and font of text and the style of gridinzs arcund the fields. It also

ircludes z logo and various formatting options.

Answer option A is incorrect. This tab 15 not displeyed 10 Form Layout Tools.

QUESTION: 38
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You work as a Database Designer for Tech Perfect Inc. The company has a Windows Vista-based computer with Microsoft Office 2010 installed
on it. The computer has a database named Sales created in Microsoft Office Access 2010. The database contains detailed information about
thousands of orders. You want to summarize these orders to illustrate the rate of growth of the company's sales. Which of the following

database objects will you generate to accomplish the task?

© A: Macro
@ B: Module
i C: Report

@ D: Query

Explanation: Answer option Cis correct.
To summarize the orders, you should create a report in Microsoft Office Access 2010.

In Microsoft Office Access 2010, a report is a database object that is used to display information in a well formatted way. The reportis
displayed on screen or on paper. |t cannot be used to enter or edit information. A user can view reports in the Report, Design, Print, and

Layout views.

Answer option A is incorrect. In Microsoft Office Access 2010, a macro is a database object that defines the actions that are required for
Access to perform as a result of a defined event. It is also used to open and execute queries, open tables, and print or view reports. A user

can add simple conditions in macros to specify when actions are performed or skipped.

QUESTION: 39

‘You waork as a Database Designer for Tech Perfect Inc. The company has a Windows Vista-based computer with Microsoft Office 2010 installed
on it. The computer has a database named OrdersDatabase created in Microsoft Office Access 2010. The database contains several tables.
‘You have created a report named OrdersRepart, which is connected to a table named OrdersTable. After some days, you have renamed the

table as Ordersinfo. How will this change affect the report?

" A: The report will be disconnected.
' B: The report will generate an error.
2 The report will look blank.

@ D: The report will not get affected.

Explanation: Answer option D is correct.

After renaming the table, you will find that the report will not get affected. The report will remain connected to the table and work

successfully.
Answer option A isincorrect. The report will remain connected to the table and work successfully.
Answer option B is incorrect. Mo error will be generated after renaming the connected table.

Answer option Cisincorrect. The report will display the information from the connected table.

QUESTION: 40
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Chcoss= and re-order the steps that you will take to create areport based on the Staffs takle in Microsoft Office Access 2010,

Requirec steps Steps

A jﬂ Clck the Report tool. A
Clck the Home tab.

Clck the Lakel tool.

Jj Type a nzme for the report.
Clelk the OK button.

Cleck the Save button.

Clek the Creats tah

In the Navigation pane. click the Staffs tabe.

T — T — 3 | Kl — T — e

Explanatien: Take the following steps to create a report in Microsoft Office Access 2010:

e In the Navigation pane, click the table that is required to be used in the report.

| All Access Objects = «
|Search, |o
Tables P

s

: = Emplovee query

 Forms & ]

|\ FE  Customer data

| Reports 1 2
B sales report

e Click the Create tab.

ﬂ_HJme External Data Databzse Tools Fields Table

8 I D K& BEEOG
5] ] o [] Nav
Application = Table Table SharePoint Query Query  Form  Form  Blank

Parts ~ Design  Lists ~ Wizard Design | Design Form %Mo
Templates Tables Queries | Forms

o Click the Report tool on the Reports group.
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e (lick the Report tool on the Reports group.

Elank
Report

Reports

QUESTION: 41

Which of the following properties binds the forms and reports to a source from which datais to be retrieved?

 A: RowSource
© B: ContralSource
@ C: Can Grow

@ D: RecordSource

Explanation: Answer option D is correct.

The RecordSource property belongs to the form and report objects. This property binds the object to a source from which data is to be
retrieved. This source can be a table or a query. When a form or a report is bound to a table or a query, the controls can be bound to a
column of the table through the ControlSource property.

Answer option Cisincorrect. The Can Grow property allows a control to adjust its dimensions according to the contents presentin the
control. A control grows vertically to adjust its contents so that all the contents can be displayed. The default value of the Can Grow
property is false.

Answer option B is incorrect. The ControlSource property bounds a control to a field of a table. If a controlis bound to a field by using this
property, the control is known as a bound control. If the value of this property is blank, the control is known as an unbound contral. If the

ControlSource property contains an expression, the controlis known as a calculated control.
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QUESTION: 42

You have a form named Assats created in Mernsoft Office Arcess 2010. You have to ma<e some changes in the formastting nf he form. For
this reazon, you have openzd the form ir the Design view. Now, you want to cisplay ruler ard grid for making the formetting easy. Which of

the following steps will you ta<e to accomplish the tas<?

" A: Click on the Design contextual tab and choose the Tocls option.
b: Right-click on the form name and choose the Format ootion.
2 Click on the Format contextuel tab and choosc the Conditional Formatting ostion.

@ D: Right-dick on Form Header, and rhonse the Ruler and Grid eptions.

Explanation: Answer option Dis corect.

In orcer to accomplish the tas<, you should take the following steps

« Right-click on Form Header.

+ Chocse the Ruler anc Grid options.

* Right-click on Form Header.
e Choose the Ruler and Grid options.

[ — | Build Event.., =t
T E
_E._ Staffs %3 Tab Order... —
# Detail B poste 1]
‘ = | & Fill/Back Color ‘ v
f =5 miternate FilYBack Color ‘ »
Employee Name [|Employee Nam * Ruler
1 Grd
W Department . "1 Page Header/Footer
|=|: Form Header/Footer
[address || Address |®F Form Properties
B Properties
Qty | city

After choosing both of these options, ruler and grid will be displayed on the form.
Answer option A isincorrect. The Tools option is not used for displaying ruler and grid on the form.
Answer option Cisincorrect. Conditional Formatting does not include any option for ruler and grid.

Answer option B is incorrect. When you right-dick the form, it does not show the Format option.

QUESTION: 43
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Which of the following Report Layout tods is used to specify the color, wdth, and line style for the outline cf the selected fielc of areport?

@ A: Format
' B: Page Setup
© (: Arrange

: Design

Explanation: Answer uplior Ais conecl,

The Format tool 's used to specify the color. width, and line style for the outine of the selected field of a report. It is also used to set font
size, font style, and backgrourd image.

[E“ Ho-wo- 5 Repoit Layout Tools o B iR
— |
“ Homz | Creste | External Da | Catabase T| Design | &rarge '|Format|‘ Page setup | @ @

2| A % = A

Fon:  Mumber Background Cantrol
= = = Formatting =

Selection | | | | |

Answer option D is incorrect. The Design tool is used to apply themes, controls, and header/footerin a repart,
Answer option Cis incorrect. The Arrange tool is used to arrange the rows and columns in a report.

Answer option B is incorrect. The Page Setup tool is used to set the page layout and page size of a report.

QUESTION: 44

You are working with a query created in Microsoft Access 2010, Mark the button that you will dick to perform the operations specified by
the query.

m Home Create External Data Database Tools I Design [ ﬁe

= A Update 0D Union
v 2l 4 A SRE:
. . ®  Fcrosstab (@ Pass-Through :
Wiew | Run Select | Make Append Query  ShowHide
S Table Woelete 2 Data Definition  Setup - -
Results Query Type

Explanation: In order to perform the operations specified by the query, you should click the Run button. It displays the datasheet of a
selected query and serves the same function as selecting Datasheet View from the View button.
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Al B 9-0- |5 = B 52

Home [ Create  ExternalData  Database Toals o @
M B:TYIYRIE M
| 3 z i
53 o == ‘:';' =
ey Paste Filter Alﬁ Refresh x E I Find L}: | Text I
y > T  Formatting =

o ¥ | Al =

Sort & Filter Recaords | Find |

Wiews |Cliph|:uard a

All Access Objects & «
|Searcﬁ... |P
Tables ~

ﬁ Salary
B starfs

 Queries
Employee query
e

Forms =

ki

I @ .&sse;:s

=
5
2
!
w
»

Bl starrs

Record: 4 ¢ 1of2 | A | < Mo Filter | Search

QUESTION: 45

You have created an arithmetic expression in an Access query to compute the results that determine fees based on a contract amount.
When you run this query, Access performs the calculations and displays the results, Choose and re-order the steps that you will take to

create the calculated field.

Required steps Steps
o jﬂ Build an expression using the operator buttons and elemen -
Click the Run button.

Click the Builder button.
jﬂ Double-click the field to be used in the calculation.
Put the insertion point in the Field row.
Type other values required to be included in the expressio
Click the OK button.

< i & -] i &
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Explanation: Take the following steps to create a calculated field:

1. Put theinsertion pointin the Field row of a blank column in the Design grid.

T
Field: |Price Vendor Code Product Il :‘
Table: |Products Products Products
Sort: | Ascending | |
Show _ | ' !
Criteria:
or 2 i g
Put the insertion point

2. Click the Builder button.

Datahase Tools | Design |

% x' 00 Union H,L j*ﬁInsert Rowrs uﬁJ Insert Columns

ass-Throug | = Delete Rows elete Calumns
s Pass-Th h =2 Dielete R #Dlt Col

Crosstab Delete Show T

7, Data Definition | Taple

iy Type

3. Double-dick the field to be used in the calculation.

4. Build an expression using the operator buttons and elements area,
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4, Build an expression using the operator buttons and elements area.

5. Type other values required to be included in the expression.

6. Click the OK button.

| Enbx o pkeason o ke the elcukibed miery ol
{Examples of expressions indude [field1] + [fieldZ] and [field1] < 5)

Avg

L Ok |
Choose the field

Expression Elements Expression Categories ion Values
U Low Price CL Average Date/Time a

Build an expression

=) Functions Domain Aggregate Count
@I@ BuiltIn Error Handling Max
! e Finandial Min
i @ Vendor General Sthev
f(f) Web Services Inspection StDevP
-3E] Vendor.accdb :ath 3“'“
_____ B essages ar
I!H Corbans Program Flow \VarP
----- f) Operators SOl Aggregate |
ﬁ' Common Expressions Text o,

Avalexpression
Calculates the arithmetic mean of a set of values contained in a spedified field on a query.

7. Click the Run button.

Create External Data Database Taols [

ﬁ %' +' % Update D) Unian

¥ . ¢ Crosstab (@ Pass-Through
Select | Make Append o
Table W Delete @7, Data Definition
Results Query Type

QUESTION: 46

Get Latest & Actual IT Exam Dumps with VCE and PDF from Pass4itSure.
https://www.Pass4itSure.com



O Instant Download 0 PDF And VCE O 100% Passing Guarantee [1 100% Money Back Guarantee

Which of the following statements are true about an expression used in Microsoft Office Access 20107

Each correct answer represents a complete solution. Choose all that apply.

[T A: Itisaset of logical or mathematical operators, functions, and constants.
[T B: It performs a calculation.
[T C: It defines the actions needed to perform as a result of a defined event.

¥ D: It manipulates character or test data.

Explanation: Answer options D, B, and A are correct.

An expression is a set of logical or mathematical operators, functions, constants, and names of field, control, and property. It evaluates to ¢

single value. An expression performs the following functions:

« Manipulate character or test data.

« Perform a calculation.

QUESTION: 47

You are working on a table named Students created in Microsoft Office Access 2010. You are required to retrieve the addresses and phone

numbers of all students from the table more quickly. Which of the following features of the table help you in performing the task?

Each correct answer represents a complete solution. Choose two.

7 A: Input mask
¥ B: Primary key
F C: Index

7 D: Validation rule

Explanation: Answer options B and C are correct.

QUESTION: 48
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You have opened an Access form n the Design view. Tke form has header and footer. You want to save the entire form as the report. What

will you co?

& A: (lick the Save As button and choose the Report option.
© B: Access does not allow you to save the “orm as the report.
€ (lick Report Wizard and follow the procedure.

' [D: Delete the ‘orm heeder and footer and click the Save As Report option.

Explanation: Answer option A ‘s correct.

In arder to save the entire form as the report, you should open the form in the Design view and then dick the Save As button.

(Al 4 E‘___” Click the Save As ELlLE
File Home ] Create External Data Database Tools @ e
ja’a Y%l?v@az ma’;. A
P_aste - Filter Ry Refresh — Find - Text
- » ¥ 7R Al X~ B & ~ | Formatting ~
Wiewrs ‘Clipbuard |  Sort &Filter | Records Find
Al Access 0.. © «
Search.. = ]
| £ —| Staffs
Tables A |
14
B4 salay
D
B3 staffs
Queries R Employee Name |James E
= Emplovee query
Forms 2
F— i Department Sales
Reports [ | 5
B sterfs Address 800 Riverton Way
City [ Mammaoth v
Record: M « 10f2  » M b | ' NoFilter | search »

QUESTION: 49
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You work as a Database Designer for Tech Perfect Inc. The company has a Windows Vista-based computer with Microsoft Office 2010 installed
on it. The computer has a database named Database1 created in Microsoft Office Access 2010. The database indudes two tables named
Table-A and Table-B. You want to divide Table-A with many columns and isolate a part of Table-A for security reasons. Which of the following

types of relationship will you create between both tables to accomplish the task?

" A: One-to-many relationship
@ B: One-to-one relationship
 C: Container managed relationship

' D: Many-to-many relationship

Explanation: Answer option B is correct.

In order to accomplish the task, you should create a one-to-one relationship between Table-A and Table-B. A one-to-one relationship is an
association between two tables in which each record in one table can have only one related record in another table. This type of
relationship is not generally used because it is easier to shift all the fields in one table. A one-to-one relationship is created if both of the
related fields are primary keys or have unique limitations. A one-to-one relationship performs the following tasks:

« |t divides a table with many columns.

« |tisolates part of a table for security reasons.

s |t stores short-lived data and deletes this data by deleting the table.
e |t stores information that applies only to a subset of the main table.

QUESTION: 50

You want to perform the folowing tasks to manipulate data before importing it into Access:

« Add fields.
+ Combine fields.
+ Use complex mathematical functions.

Which of the following is the best place to perform the above listed tasks?

7 A: Text file
B HTML file
@ C: Excel worksheet

' D: Outlook folder

Explanation: Answer option Cis correct.
A Microsoft Office Excel worksheet is the best place to perform the following tasks to manipulate data before importing it into Access:
+ Add or remove fields.

+ Combine or split fields.
+ Use complex mathematical functions.

QUESTION: 51
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Which of the following is used to control values of a field entered by a database user?

' A: Validation text
' B: Datatype
2 Index

@ D: Input mask

Explanation: Answer option D is correct.

An input mask is used to control values of a field entered by a database user. The input mask indudes literal characters, for example, space,
dot, parenthesis, and placeholder. Microsoft Office Access contains a number of pre-defined input masks that match with most of the
conditions. A user can create customized masks according to his needs. The Input Mask Wizard is used to create an input mask for text and
date fields. If the user wants to create an input mask for numeric fields, he should enter the formatting symbol himself.

Answer option A isincorrect. Validation text is used to provide an error if data has not been filled as per the Validation Rule.

Answer option Cisincorrect. In Microsoft Office Access 2010, an index is a list of field values incduded in a table. It helps Access in finding
and sorting records quickly. An index stores the record's location based on the columns that are part of the index. The indexed fields have

unique values which make it more efficient and faster for Access to read and find a specific field value.

Answer option B is incorrect. Datatype defines the kind of data that a field can accept.

QUESTION: 52

You want to group by Sales Region to see all records for each sales region together, with a total of sales for each region. Mark the but
that you will click to accomplish the task.

@ B colors - Elg = Totals @W Aq i E @d ;E =l |- E

Wiew | Themes [AlFonts ~ Group ngide Dretails — Insert
= - A Sort T Image~

Wiews Themes Grouping & Totals Controls

Explanation: In order to accomplish the task, you should click the Group & Sort button in the Grouping & Totals group.

o

|T‘_'
ECoIors' [E“ Z Totals
|

Wiew | Themes [A]Fants v | [ SrOUP |75 Hide Details
- - | & sart

Wiews Themes Grouping & Totals

When you dick this button, Access displays all records for each sales region together, with a total of sales for each region.

QUESTION: 53
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You work as a Database Designer for Tech Perfect Inc. The company has a Windows based environment. A database file created in Microsoft
Office Access 2010 1s shared over the network and multiple users work directly with the file simultaneously. The database file has a small risk
of becoming corrupted. The risk of corruption is greater if users often modify datain Memo fields, and the risk grows over time. Which of

the following will you use to mitigate this rsk?

 A: Linked Table Manager
' B: Database Documenter
© C: Back Up Database

€ D: Compact and Repair Database

Explanation: Answer option D is correct.

In order to mitigate the risk, you should use the Compact and Repair Database. The Compact and Repair Database is a command used in
Microsoft Office Access 2010. It rearranges data, fills up the spaces left behind by the deleted objects, and repairs the problems. It

compresses the database if any problem is encountered in the Access database.

Answer option Cis incorrect. The Back Up Database is used to save the database file to a removable disk or network drive to ensure that itis

safe from problems.

Answer option A is incorrect. The Linked Table Manager is used to list the paths to all currently linked tables.

QUESTION: 54

You work as a Database Designer for Tech Perfect Inc. The company has Windows Vista-based computer with Microsoft Office 2010 installed
on it. The computer contains a database named Products created in Microsoft Office Access 2010. You want to add an Access template to

the database in order to extend its functionality. Which of the following Access templates will you use to accomplish the task?

 A: Northwind
' B: Tasks
7 (: Assets Web Database

@ D: Application part

Explanation: Answer option D is correct.

In order to accomplish the task, you should use the application part. An application part is a template available in Microsoft Office Access
2010. It can be added to an existing database. Itis used to extend the functionality of an Access database. It can indude only a single table
or a number of database objects, such as tables, forms, reports, and even relationships. A user can open up the Application Parts gallery in
order to view the built-in parts.

Answer option Cis incorrect. The Assets Web Database template keeps track of assets. It also dassifies and records the status of assets.

Answer option A isincorrect. The Northwind template creates an order tracking system that organizes customers, employees, order details,

and inventory.

QUESTION: 55
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You work as a Database Documenter for Tech Perfect Inc. You have a database named Database1 created in Microsoft Office Access 2010.
This database contains three tables named Products, Orders, and Order Details. You want to manage the tables in such a way that each
record in the Orders table will have many records in the Products table and each record in the Products table will have many records in the
Orders table. What should you do to accomplish the task?

© A: Create a container-managed relationship.
7 B: Create a one-to-one relationship.
@ C: Create a many-to-many relationship.

' D: Create a one-to-many relationship.

Explanation: Answer option Cis correct.

In order to accomplish the task, you should create a many-to-many relationship between the Orders table and the Products table. You can

define this relationship by creating two one-to-many relationships to the Order Details table.

Answer option B is incorrect. A one-to-one relationship is created between two tables in which each record in one table can have only one

related record in another table.

Answer option D is incorrect. A one-to-many relationship is created between two tables in which a row in the first table can have one or
more matching rows in the second table, but a row in the second table can have only one matching row in the first table.

QUESTION: 56
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You work as a Database Designer for Tech Perfect Inc. The company has a Windows Vista-based computer that has Microsoft Office 2010
installed on it. The computer has a database named 5ales created in Microsoft Office Access 2010. The database contains a table named
Products. Some records in the table are incomplete or missing. You need to complete the records. For this reason, you want to rearrange the
table in such a manner that it displays the incomplete or missing records on the top of the respected column. What will you do to accomplish
the task?

Each correct answer represents a complete solution. Choose two.

¥ A: Select the column and dick on the Ascending button.
7 B: Select the column and dick on the Toggle Filter button.
¥ C: Right-dick on the column header and choose the Sort Smallest to Largest option.

I” D: Select the column and click on the Descending button.

Explanation: Answer options A and C are correct.

In order to accomplish the task, you will have to perform one of the following tasks:

s Select the column and dick on the Ascending button.

?Selecticun -

EAduanced .3

Filter
i/ Remaove Sort ¢ Toggle Filter

Sort & Filker

[ =

- R SR

o
= o

12|
13
14
15 |
16 |
(Mew)
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You work as a Database Designer for Tech Perfect Inc. The company has a Windows Vista-based computer with Microsoft Office 2010 installed

on it. The computer has a database named SalaryData created in Microsoft Office Access 2010. This database has a report named
SalaryReport. You have to determine bonuses based on a percentage of sales and display it in the report. For this, you want to insert an

arithmetic expression in the report. Mark the tab/button that you will use to accomplish the task.

E\]Themes' = Group & Sort ) j B ﬁﬁ =
*@ B?E

n Colars = X Tofals =
e == Controls Insert Page Add Existing
- Fonts' 1= Hide Dretails ¥ Image Mumbers L Fields
Wieans Thermes | Grouping & Totals Contrals Header / Foo,.. Tools

Explanation: You should click on the Property Sheet button displayed on the Design contextual tab. Itis used toinsert an expression for the
calculation. You can also use the Property Sheet button to define formats for dates, currency, and other numeric data.

i Themes - [E Group & sort g*i 2 :_I % Iiﬁ =
Colors~ | X Totals:= = | -
Controls Insert Page Add Existing Property
* Image Mumbers E Fields

Too

Wiew =g
i Fonts | 153 Hide Details
Header f Foo.. |

Wiews Themes | Grouping & Totals | Controls

QUESTION: 58
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